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Using JRebel 3 with Seam 2.x Tutorial

What is JRebel?

JRebel is a JVM plugin (-javaagent) in the form of a commercial software developed by ZeroTurnaround (www.zeroturnaround.com) that enables you to see changes to your code the next time your modified class is accessed, without the need to redeploy an application or perform a container restart. If you're tired of watching the logs roll by, and want to see your changes so that you can keep going - JRebel is your new best friend.  You will save much time during your daily dev/build/deploy/test cycles when using JRebel with your Seam/EE5 apps.  One significant and exciting new feature in JRebel 3 is the ability to hot redeploy interface changes to EJB3 session beans as well as hot redeploy additions/subtractions of Seam and EJB annotations in your JavaBeans and EJB components.

http://www.zeroturnaround.com/reference-manual/intro.html#intro

How does JRebel work?

http://www.zeroturnaround.com/jrebel/faq/#How_does_jrebel_work

http://www.zeroturnaround.com/reference-manual/intro.html#intro


What does JRebel provide that HotSwap and Hot redeploy don’t?

Read this article on the feature comparison matrix: http://www.zeroturnaround.com/jrebel/comparison 

What about the special Seam classloader in Seam 2.x?

The Seam incremental hot deploy feature does not support incremental hot deploy of EJB 3 session beans or entity classes.  JRebel 3 does (there is experimental support for entities for OpenJPA currently).  JRebel also supports hot redeploy of @In and @EJB annotation modifications (add/delete).

What is the latest version of JRebel?
Download JRebel here: http://www.zeroturnaround.com/jrebel/current/
As of this writing, the latest stable version is JRebel 3.0 stable release (~ 10mb | 16th April 2010)
 This tutorial is written using 3.0.1 due to a bug in the 3.0 stable release which will prevent the successful hot redeployment of interface changes in a session bean.
What are the new features in JRebel 3?
http://www.zeroturnaround.com/news/jrebel-3-0/
What does this tutorial cover?
This tutorial uses the Seam distro’s hotel booking application to demonstrate 
1) how to incrementally hot deploy (aka  hot redeploy) interface changes to a stateful session bean by adding a public method and accessing that method without a full rebuild/deploy cycle to JBoss AS 
2) how to hot redeploy adding a @In Seam injection for a newly coded Seam component (JavaBean) in the same stateful session bean
Tutorial Pre-requisite installations
Please install the following prior to installing JRebel 3:
1) Sun JDK 5 http://java.sun.com/javase/downloads/index_jdk5.jsp - as of this writing it’s JDK 5.0 Update 22)
2) JBoss AS 4.2.x http://www.jboss.org/jbossas/downloads/ 
3) JBoss Tools 3.x http://relation.to/Bloggers/JBossTools31Final (we will be using the JBoss server view)
4) Eclipse Galileo 3.5 http://www.eclipse.org/downloads/ - (Eclipse IDE for Java EE Developers is a good option)
5) Seam 2.1.x.GA http://www.seamframework.org/Download (Seam 2.0 and 2.1 examples target JBoss Application Server 4.2 or 5.0.)
6) Apache Ant 1.7.x (simply extract to any directory and setup ANT_HOME environment variable like this in Windows: C:\java\apache-ant-1.7.1)
if you’re going to build from command line rather than Eclipse
You are welcome to try JBoss AS 5.1 with Seam 2.2.x but I have not tried that combo yet with JRebel 3.x.
JRebel Installation (Windows installer):
Download JRebel 3.0.1 (or later) from this link:  http://www.zeroturnaround.com/jrebel/next-releases/ (select the Windows installer)
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Double-click the jrebel-nightly-setup.exe above; keep clicking next (accepting defaults) and then Finish.  The JRebel configuration wizard is optional for this tutorial but I have included the screenshots just in case.
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Click Finish
Launch Eclipse
Create a new workspace
Import the Seam hotel booking application from the Seam 2.2.x distro located here: %SEAM_HOME%\examples\booking
Generate a rebel.xml via the plugin
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Click ok to save rebel.xml in booking/resources directory.  NOTE: this xml file will need to be located in %SEAM_HOME%\examples\booking\exploded-archives\jboss-seam-booking.jar directory.  We will modify the build.xml file later to ensure it is added to the JAR artifact.  The rebel.xml tells JRebel what directory or directories to monitor for changes and subsequent reloads.  To reload the EJB components put a rebel.xml into the root of the EJB jar(s). To reload the WAR classes put rebel.xml into WEB-INF/classes. So in the end you'll need 2 rebel.xml files for most projects but for this tutorial we only need to generate one rebel.xml for the JAR because we are only working with one SFSB.


JRebel plugin creates this rebel.xml file for you:
<?xml version="1.0" encoding="UTF-8"?>
<application xmlns:xsi="http://www.w3.org/2001/XMLSchema-instance" xmlns="http://www.zeroturnaround.com" xsi:schemaLocation="http://www.zeroturnaround.com/alderaan/rebel-2_0.xsd">

	<classpath>
		<dir name="C:/java/jboss-seam-2.1.1.GA/examples/booking/exploded-archives/jboss-seam-booking.jar">
		</dir>
	</classpath>

</application>
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Hot redeploy scenarios
Add a HtmlCommandButton to main.xthml in the form with id=”searchCriteria”:
<h:commandButton action="#{hotelSearch.jrebel}" value="JRebel!"/>
Add a method to HotelSearching local interface:
//public void jrebel();
Add a method to HotelSearchingAction SFSB class:
//public void jrebel(){ System.out.println("JRebel!"); }
Modify C:\java\jboss-seam-2.1.1.GA\examples\ build.xml to add the rebel.xml reference below so the rebel.xml is included in jboss-seam-booking.jar:
<fileset id="jar.resources" dir="${resources.dir}">
		<include name="import.sql" />
		<include name="seam.properties" />
		<include name="rebel.xml"/>
		<include name="seam.quartz.properties" />
		<include name="*.drl" />
		<include name="META-INF/persistence.xml" />
		<include name="META-INF/ejb-jar.xml" />
		<include name="META-INF/orm.xml" />
		<include name="META-INF/components.xml" />
		<include name="META-INF/jboss.xml" />
		<include name="META-INF/security-config.xml" />
		<include name="META-INF/security-rules.drl" />
		<include name="META-INF/standard-jaxws-endpoint-config.xml" />
		<include name="*.jpdl.xml" />
		<exclude name=".gpd*" />
	</fileset>
In case you have JDK 1.6 and 1.5 installed on your workstation, make sure your Eclipse compiler settings are set to 1.5 by going to project -> properties -> java compiler and checking the “enable project specific settings” and then select 1.5 for “compiler compliance level”.
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Build and deploy app using ‘ant clean explode’ command (run ‘ant unexplode’ or ‘ant undeploy’ first as required)
In this directory of the exploded EAR, C:\java\jboss-4.2.2.GA\server\default\deploy\jboss-seam-booking.ear\jboss-seam-booking.jar, you should see the rebel.xml file.  If it’s not there then the rebel.xml was placed in the incorrect directory (it should be in booking/resources) and double-check the build.xml re-config above.
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If not already created, add a JBoss server in the JBoss server view
Right-click in white space; select new  server
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Select JBoss AS 4.2, click Next
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Enter your JBoss home directory, select JDK 1.5, select default instance, click Next
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Click Finish

Enter the path to jrebel.jar via Window  preferences  JRebel

[image: ]

Click the enable debug logging checkbox in JRebel tab of Edit launch configuration properties.
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Make sure the VM args in the edit configuration screen (from JBoss server view, double-click your server, click open launch configuration link) look similar to this (the JRebel-specific args are highlighted and required):

-noverify -javaagent: "C:\Program Files\ZeroTurnaround\JRebel\jrebel.jar" -Drebel.jboss_plugin=true -Drebel.allow_bytecode_proxy=true -Drebel.log=true -Dprogram.name="JBossTools: JBoss 4.2 Runtime" -Xms256m -Xmx512m -XX:MaxPermSize=256m –
Dsun.rmi.dgc.client.gcInterval=3600000 -Dsun.rmi.dgc.server.gcInterval=3600000 -Djava.endorsed.dirs="C:\java\jboss-4.2.2.GA\lib\endorsed"
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Start JBoss AS 4.2 via JBoss Server view (right-click on JBoss 4.2 Runtime Server and select debug)

Check the Eclipse console and/or JBoss server.log to make sure that there are no exceptions during server startup and booking app deployment

At the very top of your Eclipse console, you should see this output:
#############################################################

 JRebel 3.0.1-SNAPSHOT (201004161402)
 (c) Copyright ZeroTurnaround OU, Estonia, Tartu.

 Over the last 1 days JRebel prevented 
 at least 0 redeploys/restarts saving you about 0 hours.

 You are running JRebel evaluation license.
 You have 2 days until the license expires. 

 You will see this notification until you obtain a 
 full license for your installation. 
                                                          
 Visit www.jrebel.com for instructions on obtaining    
 a full license. If you wish to continue your evaluation  
 please e-mail to support@zeroturnaround.com.             
                                                          
 If you think you should not see this message contact     
 support@zeroturnaround.com or check that you have your   
 license file in the same directory as the JAR file.      

 The following plugins are disabled at the moment: 
 * Hibernate Plugin (set -Drebel.hibernate_plugin=true to enable)
Reloads SessionFactory when configuration changes
 * Log4j plugin (set -Drebel.log4j-plugin=true to enable)
Reloads full configuration of log4j
 * OpenJPA Plugin (set -Drebel.openjpa_plugin=true to enable)
Reloads EntityManagerFactory when configuration changes
 * Stripes plugin 1.0.11 (set -Drebel.stripes_plugin=true to enable)
Adds reloading of Stripes ActionBeans.

#############################################################
You should see output similar to this:
JRebel: Directory 'C:\java\jboss-seam-2.1.1.GA\examples\booking\exploded-archives\jboss-seam-booking.jar' will be monitored for changes.	
which is based on the metadata provided in the rebel.xml file for the directory for JRebel to monitor for changes:
<?xml version="1.0" encoding="UTF-8"?>
<application xmlns:xsi="http://www.w3.org/2001/XMLSchema-instance" xmlns="http://www.zeroturnaround.com" xsi:schemaLocation="http://www.zeroturnaround.com/alderaan/rebel-2_0.xsd">
		<classpath>
<dir name="C:/java/jboss-seam-2.1.1.GA/examples/booking/exploded-archives/jboss-seam-booking.jar">
			</dir>
		</classpath> 
</application>
You should also see JRebel specific logging for the various enabled JRebel plugins:
=============================== [JRebel JBoss Plugin] ===============================
You can disable this plugin using Agent Settings or by setting -Drebel.jboss_plugin=false.
------------------------------------------------------------------------------------------
Description: Supports adding new methods to ejb interfaces and injecting new
@EJB fields.
=============================== [/JRebel JBoss Plugin] ==============================

=============================== [JRebel Hibernate Plugin] ===============================
You can disable this plugin using Agent Settings or by setting -Drebel.hibernate_plugin=false.
------------------------------------------------------------------------------------------
Description: Reloads SessionFactory when configuration changes
=============================== [/JRebel Hibernate Plugin] ==============================

=============================== [JRebel Mojarra (JSF-RI) Plugin] ===============================
You can disable this plugin using Agent Settings or by setting -Drebel.mojarra_plugin=false.
------------------------------------------------------------------------------------------
Description: Turns on Mojarra development mode. Reloads JSF configuration and
reconfigures managed beans.
=============================== [/JRebel Mojarra (JSF-RI) Plugin] ==============================

JRebel: Directory 'C:\java\jboss-seam-2.1.1.GA\examples\booking\exploded-archives\jboss-seam-booking.jar\org\jboss\seam\example\booking' will be monitored for changes.
=============================== [JRebel Seam Plugin] ===============================
You can disable this plugin using Agent Settings or by setting -Drebel.seam_plugin=false.
------------------------------------------------------------------------------------------
Description: Turns on seam debug mode and reconfigures modified seam components.
=============================== [/JRebel Seam Plugin] ==============================

=============================== [JRebel Facelets Plugin] ===============================
You can disable this plugin using Agent Settings or by setting -Drebel.facelets_plugin=false.
------------------------------------------------------------------------------------------
Description: Turns on facelet development mode, facelet reloading and reloads
facelet tag libraries.
=============================== [/JRebel Facelets Plugin] ==============================

First Demo: adding interface method to SFSB

   For the first demo, we are going to add a local interface method and SFSB impl class method for hot redeploy in the hotelSearching Seam component.

1) Stop the JBoss server
2) Execute ‘ant clean unexplode explode’ from the Ant view in Eclipse (one target at a time) or all at once from command line here: C:\java\jboss-seam-2.1.1.GA\examples\booking
3) Start the JBoss server in debug mode (or regular start/run mode)
4) Navigate to http://localhost:8080/seam-booking
5) Login using demo/demo credentials
6) On the main.xhtml page, click the new <JRebel!> Button
7) You should see this in your console or server.log:
16:01:14,474 ERROR [[Faces Servlet]] Servlet.service() for servlet Faces Servlet threw exception
javax.el.MethodNotFoundException: /main.xhtml @42,71 action="#{hotelSearch.jrebel}": Method not found: HotelSearchingAction:4si4k5i-6szw7-g7zb48zq-1-g7zbee2g-i.jrebel()
8) Edit the HotelSearching local interface by uncommenting the newly added line:
public void jrebel();
9) Edit the HotelSearchingAction SFSB class by uncommenting the newly added line:
public void jrebel(){ System.out.println("JRebel!"); }
10) navigate back to main.xhtml (click browser back button)
11) click <JRebel!> button again
12) You will see the following output in the console: “JRebel!”
13) You will also see the following output in the console:
JRebel-JBoss: Reconfiguring EJB 'jboss.j2ee:service=EJB3,name=HotelSearchingAction' [org.jboss.seam.example.booking.HotelSearchingAction]

Second Demo: adding @In to SFSB

   Now for the second demo we are going to dynamically add a Seam @In injection to the HotelSearchingAction SFSB and see what happens.

1) Write this class:

package org.jboss.seam.example.booking;

import org.jboss.seam.annotations.AutoCreate;
import org.jboss.seam.annotations.Name;

@Name("testInject")
@AutoCreate
public class TestInject {
	private String foo = "bar";

	public String getFoo() {
		return foo;
	}

	public void setFoo(String foo) {
		this.foo = foo;
	}
}

Add the following commented code to the HotelSearchingAction SFSB:

//@In(required=false)
//private TestInject testInject;

Then change the jrebel() method to look like this (we’re adding the commented line to output the value of foo):

public void jrebel(){ 
		   System.out.println("JRebel!");
   //System.out.println("testInject.getFoo() = "+testInject.getFoo());
}
2) Stop the JBoss server
3) Execute ‘ant clean unexplode explode’ from the Ant view in Eclipse (one target at a time) or all at once from command line here: C:\java\jboss-seam-2.1.1.GA\examples\booking
4) Start the JBoss server in debug mode (or regular start/run mode)
5) Navigate to http://localhost:8080/seam-booking
6) Login using demo/demo credentials
7) On the main.xhtml page, click the new <JRebel!> button
8) You will see the output in the console: “JRebel!”
9) Uncomment the commented lines in HotelSearchingAction SFSB above.
10) Save (if using Eclipse, make sure Project  Build automatically is checked)
11) Click the <JRebel!> button again
12) You will see the following output in the console: 
10:22:04,519 INFO  [STDOUT] JRebel!
10:22:04,519 INFO  [STDOUT] testInject.getFoo() = bar

So JRebel was able to hot redeploy the Seam @In addition to our EJB!

This concludes the tutorial for using JRebel 3 with Seam 2.x.  There will be followup Weld/JRebel3 and Seam3/JRebel3 tutorials as well in the near future so stay tuned.

Thanks!
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ol means () the power, direct ar ndect, to cause the direction or management of such entity, whether by cantract or o
thervise, or (i) ownerstip of Ffty percent (50%) or more of the outstaning shares or beneficial ownership of such entity

2. DEFINITIONS
(2)"Authorized User” means (1) Licensee is an ndvicua, solely izensee; () F License Is 2 legal entity, any emplayee, i
nependent cortractar or ather temparary worker autharized by Licensee ta use JRebel whie performing duties within the
scope of their employment or assignment.

(5) "IRebel” means the softuwere program known as JRebel, as produced by ZeroTurnaround, i binary form, including s

@ Laccept the terms ofthisIcense agreemert.

O 1o not accep theterms of thi cense agreeren.





image4.png
[&) JRebel - Install

whatsnew () ZEROTURNAROUND

Please read the following information:

JavaRebel Changelog

3.0 (15th April 2010)

* Fixed an issus with GuiceComponentReloader and cosed dass loaders
* Fixed an issus with rebelxmi being inored by AppClassLoader

3.0RC2 (13th Apri 2010)
* Impraved perfomance of resource finding on Windaws
* Changing super class now causes a SuperClassChangedException to be thrown.

* JRebelwil now cal the static method _ rebelReload() after each reload, F t exits.
* Enabled plugins o langer display any cansole outpu, disabled plugins are lsted with the JRebel

;





image5.png
[&) JRebel - Install

tagetratn (1) ZEROTURNAROUND

Select the instalstion path:
(CProgram FilsiZeroTurnaroundi Rebel Bronse.





image6.png
[&) JRebel - Install

Setup Shortcuts

Create shortzuts inthe Start-Menu

Select a Program Group for the Shortcuts:

72p

Accessaries

diistrative Tools

attachmate Reflection

avaya

Eroadcom

Cisca

Cirix

Core FTP.

Enterprise Architect 7.0
lezila FTP Clent

(") ZEROTURNAROUND

create shortcut for:
© current user
@ alusers

Rebel





image7.png
[&) JRebel - Install

Installation

Pack installation progress:

Overall installation progress:





image8.png
& JRebe! - Install EEX

(") ZEROTURNAROUND

Congratulations!

Installation of JRebel was finished succesfully.
Pressing "Finish" wil close this window.

JRebel Configuration Wizard wil be lzunched automatically.
Untick the checkbos below if you have already configured your environment.

sunch JRebel Configuration Wizard





image9.png
(@) JRebel Configuration Wizard

Choose settings Please select your development environment:

Integrated Develapment Environment (IDE): [Ecinse 3.3 or later

IDE Gonfiguration

(1 use Maven to buid my appication
Application Configuration
) 1 run the server from my IDE

Server Configuration

Agent Settings





image10.png
[®) JRebel Configuration Wizard

Choose settings IDE Configuration Guide: Eclipse 3.3 or later

IDE Gonfiguration
Install the JRebel Eclipse plugin by going to Help » Software updates » Available software » Add site and use the

Application Configuration | | bte/sne zerotumaround comupdate-site/ URL as the update site. For offine instalation use the downloadable zp archive
(bt forurw zeroturnaround com/update-sitefupdate-site zip) instead. The WTP plugin is only necessary if you run the server from
Eclipse.

"5 Software Updates and Aad-r: WA

Installed Software| Available Softuware|

Server Configuration

Agent Settings

type filter text

Neme Version
4[] ¥l http:/fwnww zeroturnaround. com/update-site
4 1000 JoveRebel
[C] 4 JavaRebel Eclipse Debugger Integration 10.0.200904291305
[C] 4 JavaRebel Eclipse Integration 100.200904291305
[C] 45 JavaRebel WP Integration (Optional) ~ 10.0.200904291305

Properties

Show only the latest versions of available software
Include items that have already been installed

Open the ‘Automatic Updates' preference page to set up an automatic update schedule.

T | |





image11.png
(@) JRebel Configuration Wizard

Choose settings IDE Configuration Guide: Eclipse 3.3 or later

IDE Configuration Once the plugin is installed 2o to Window » Preferences » JRebel, brawse to the instalation directory and select the jrebel. jar

application Configuration | | = preferences =la

Server Configuration typefilter text JavaRebel

 Java
Path to javarebel jar
Agent Settings » JavaRebel Jj 1

et Chienvebeovrcelor

A
Maven
Plug-in Development

. =
Run/Debug oy

o[ cne ]

Go to Window » Preferences and from there to Java » Debug » Step Filtering

Check Use Step Filters, Filter synthetic methods, and Step through filters. Now check all the default fiters and use the Add
Filter button to add com.zerotwrnaround. * and org.zeroturnaround. *

© Preferences

ey fiter text Step Fiitering

General T 7
o cortroter [ e e
ant

Backuard Compa
et Reprte Defined step fiers:

Deta 2L 8 com i r

() ) (o

Use step Fiters:





image12.png
[®) JRebel Configuration Wizard

Choose settings IDE Configuration Guide: Eclipse 3.3 or later

5 Code Style (Pt

0 Compler Deselect Al

= Debug
Application Configuration Detai For © javalang ClssLoader

Heap Wa
Lot ot Fier synthetic methods (recuires YM support)

Server Configuration primtivel | [JFike statc ntilzers

IDE Gonfiguration

StepFite | [riterconstructors

Agent Settings & Edtor op trough fiters
& Tntaled e | [0 hroush i

iy

Open Project
Close Project

cuid e
Suid proct
uld oringSet

S cenerate Javadoc
Conwert to a Dynamic Web project.

Propertiss

©  public void validate[Owner owner
i if (IStringUtils.haslength(o

o ] () (o





image13.png
[®) JRebel Configuration Wizard

Choose settings Application Configuration Guide: Eclipse 3.3 or later

A

1DE Configuration
Click on your project and pick Generate rebel.xml.
Application Configuration
8%
Server Configuration
) Showin Aksshiw
Agent Settings i
copy e
2 Copy Qualfed e
2 paste ey
3 Dekte Oektz
8 Remavefrom Context Cirle Al shit+Down
Suidpath
Refactor AkashiteT

Import
Export

£ Refresh
Close Project
Close Unvelated Projecs

Valdate

Run A
Debug s |
Profi < =

You need to have one rebel sl file per module. This includes both web and EJB modules. The rebel sl configuration file should
e placed in your WEB-INF/classes directory in the case of a web module and in the jar root in the case of an EJB module. Put it
in the root of a source or resource folder in your project (the same place where the properties files are). Repeat this for all

o ] () (o





image14.png
[®) JRebel Configuration Wizard

Choose settings Application Configuration Guide: Eclipse 3.3 or later Configure manualy.

1 e T00T 0T & SGUFCE O TESOUrCe TOIder i Our Froject (He Sarme FIACE Wiiere e Properties Tes are). Kepeal s for all
projects that you'd like to update with JRebel

Application Configuration | | The pugin generates the rebel xml with absolute paths to your workspace. This might be a bad idea as you'd like to share i with

other teatm mernbers. Luckly JRebel will expand expressions lice "${(myproject root)” in rehel.xnl to a property that you
Server Configuration provide. You can set this property as a Java Systen property (-Dyproject. root=c: /projects/) or in the JRebel Agent
Configuration

Agent Settings JRebel Agent Settings

IDE Configuration A

Logging || Plugins | Features [ custom

Custom properties

Name Value
myproject.ioot Chprojects myproject

myproject. oot

Ciyprojects\myproject

Reset | [ Load defaults

o ) (o) o





image15.png
[®) JRebel Configuration Wizard

Choose settings Server Configuration Guide: Eclipse 3.3 or later

IDE Configuration 2~
Automatic publishing should be disabled in the server configuration. Double click on your server name and a configuration page
Application Configuration | | opens. Under the Publish section you should have the Never publish automatically option selected as shown in the following
screenshot.

Server Configuration

£ JBoss 2 at localhost % =0

Agent Settings B Overview

General Information ~ Publishing
‘Specify the host name and other common settings. Modify settings for publishing
Server name: JBoss vd.2 at localhost Never publish automaticalh

Host name: Jocalhost Automatically publish when resources change

Sntime Environment Publishing interval in seconds):  [15__[&

Open launch configuration » Timeouts

» Server Properties » Ant Publisher Properties

~ JavaRebel Integration
JsvaRebel integration
nable JavaRebel agent
) Ensble debug logging
Notice: Besure to disable Automatic Publishing

Ovenview|

If you run a standalone application you can enable JRebel for its launch configuration

oo ) [rom





image16.png
[®) JRebel Configuration Wizard
Choose settings
IDE Configuration

Application Configuration

Server Configuration

Agent Settings

Server Configuration Guide: Eclipse 3.3 or later

Configure manualy

nable JavaRebel agent
) Ensble debug logging
Notice: Besure to disable Automatic Publishing

Ovenview|

If you run a standalone application you can enable JRebel for its launch configuration

= Run Configus

Create, manage, and run configurations

CERX[B3-

Name: test

® Wi [ Common [y JawaRebal. ™

Java Applet
Java Application
=3 Enable JavaRebel agent
Jis nit ) Ensble debug logging
3 Unit Plug-in Test
» m2 Maven Build
% 056 Framework
i Task Contert Plug-in Test

Fiter matched 21 of 22 tems.

A

See manual

e ) s |

Finish

] [ Cancel





image17.png
(@] JRebel Configuration Wizard

Choose settings Agent Settings:

IDE Configuration Loggng
¥ Log to file (rebellog)

Application Configuration

Log level: default v
Server Configuration Custom log file location: Browse,
Agent Settings Enatled plugins

) Boss EJB Plugin
Finish
[0 Weblogic E36 Plugin

[0 Websphere 38 Plugin
) Aspect] Plugin

W) Facelets Plugin

[ Groovwy Plugin

) Google Guice Plugin

W) Hibernate Plugin

0 Log# pluain

(0] OpentPa Plugin

W) Seam Plugin

0 Spring Framework Plugin
(] stripes plugin

(0 struts 1 plugn

(0 struts 2 plugn

) Tapestry 4 Plugin

0 velacity Plugin

[0 wicket Pugn

Advanced.
o e ) (o) o

Ui acnin..




image18.png
[8] JRebel Configuration Wizard

Choose settings You are done now! Happy coding :)
IDE Configuration
Application Configuration
Server Configuration
Agent Settings

Finish

< Back next > | [_Fnsh_] [ Cancel





image19.png
Java EE - JBoss 4.2 Runtime Server - Eclipse.

Fle Edt Navigate Search Project Run Window Help

(wihd ¥-0-Q- G-6 IGO0
(5 Project Explorer 52 BEg| e =08
& i [~
Sime ew ,
S come
E Show In AlShife+w »
o 2 coy culec
4 5 Copy Qualied Name
E [ Paste Ctrby
4 X Dkt Delote
“
G BuldPath ,
G Refactor AksshifteT ,
4 pag Import,

“
43 Expor

4 5 Refresh Fs
Close Profect

valdate
Show in Remote Systems view

m2 Maven »
@ convert o Drooks Project
run s
Debug s
Profie
Team
Compare with
Restore from Lol Hstory.
source ,
Confgue ,

Propertiss Al+Enter





image20.png
£ Folder selection

Choose the folder for the generated rebel. i
= & bosking

& settings

& dst

& exploded-archives

& METATVE
& wes T
&
& vew





image21.png
£ Edit Configuration

Edit launch configuration properties

Below i the aunch configuretion properties for sterting J8oss Servers

Hame: | PBoss 4.2 Runtime Server

0= Arguments O Main| & Clsspath | 5 Source | B Envronment | £ Comman| () JRebel

Program argumerts:

—configuration=default -b ocahast

VM srquments:

noveriy —javaagent:"C:|Program Fles|zeroTurnaround| Rebelrebel jr" Drebel jboss_plugin=true -Drebel.alow_bytecode_pror
“Direbel log=trus -Drebel og.file="C:|Program Fies|ZeroTumaround| Rebelljebellog" -Dprogram.name="1gossTool: JBoss 4.2 Runtine”
~H15256m -KxS121n KX MaxPermize=256m -Dsun. 1. cent. acInterval=3600000 -Dsun .. g server.aclnterval
“Disva.endorsed.drs="C:ijavaljboss-4.2.2.GAllblendorsed"

Working drectory:
Opefayt:

@ other Ciljavaljboss-4.2.2.GAjbin





image22.png
£ Properties for, booking

Java Compiler
Resource
Buiders
Drocls
FreeMarker Contert
Hibernate Settings
Java Buid Path Compler complisnce level;
3ava Code Style
3ava Compier
Annotaion Processing
Buiing
ErrorsjWernings
Javador
Task Tags
Java Edtor
Javadoc Location

Modue Assembly
Project Archives dd variabe attrbutes to generated class s (used by the debugger)

nable project speciic settings

30K Complsnce

se defaul compliance settings

Classfie Generation

Project References dd e number attrbutes to generated class files (used by the debugger)
Refactoring History.

Runjpebug Settings
Seam Setings reserve unused (never read) local varisbles

dd source fle name to generated classfil (used by the debugger)

Task Repostory
Task Tags
Valdation
wikText





image23.png
Name:
CDMETAINE
Do
import.scl
rebelxml

[Sseam ropetes

Size.

e
ke
ke

Type.
File Folder

File Folder
5QLFie

XML Document
PROPERTIES File

Date Modified
3/30/2010 2:09 P
3302010 2:09 P
3302010 2:09 P
3302010 2:09 P
31302010 2:09 P




image24.png
£ New Server

Define a New Server

Choose the type of server to create

Server's host name: [locahost

Dorioad addtional server adapters

Select the server type:

type fiter text

& 3Boss
= 3Boss Community
i, Joss A5 3.2

Boss A5 4.0

JBoss 4S50
IBoss AS 5.1
IBoss A 6.0

3Bo0ss Applcation Server 4.2

Server name: 3B0ss 4.2 Runtime Server





image25.png
£ New Server

JBoss Runtime
38o0ss Applcation Server 4.2

A Jhoss Server runtime references a Jhoss instalation drectory.

© @ b ket

Tt can be used to set up classpths for projects which depend on this rukime,
s well a by a"server* which wil be able to start and stap nstances of JBoss.

Name

3B0ss 4.2 Runtime

Home Directory

Cijavaljboss-+.2.2.GA|

(Bome]

RE

j9k1.5.0_22

=

Configuration

Directory:  server

al
default
minimal

<Back

s

|





image26.png
£ New Server

Create a new JBoss Server

Tioss Applcston Server 4.2
© @ by resat

A JB0ss Server manages starting and stopping nstances of JBoss.
It manages command ine arguments and keeps track of which modules have been deployed.

Runtime Information

f the runtime information below i ncorrect, please press back, Installed Runtimes. .,
and then Add to create 2 new runtine from a dfferert locatian

Home Directory  Ciljavaljboss-4.2.2.63
RE Ciprogram Fies!Tavaljdk1.5.0 22 (jdk1.5.0_22)
Configuration Location server
Configuration default

<pack [ _mews ] (_emish ] [ concel





image27.png
£ Preferences

IJRebel

General
ant Path to rebel.jor
Alassian Connector ‘CiProgram Files\ZeroTumaroundijrebelliebel jar
epEL

Deta Management

Drodls

Draols Task

FresMerker Edtor

Guvnor

Help

HOL edior

Tnstallupdate

sava

Javake

36055 Tools

Rebel

Haven

Phagn Developmert:

Project Archives

Remote Systems

Run/Debug

Server

Tasks

Team

Terminal

Usage Data Collsctor

valdaton

vieb

tieh Services

Dockt





image28.png
£ Edit Configuration

Edit launch configuration properties

Below i the launch configuration properties for starting JBoss Servers
ame: | Boss 4.2 Runtim Server
- Arguments @ Main |, Classpath & Souce (79 Envionment | = ommon () JRebel

[JEnable JRebel agert,
Enable debug logging





image29.png
£ Edit Configuration

Edit launch configuration properties

Below i the aunch configuretion properties for sterting J8oss Servers

Nome: | JB0ss 4.2 Runtime Server

0= Arguments O Main| & Clsspath | 5 Source | B Envronment | £ Comman| () JRebel

Program argumerts:

—configuration=default -b ocahast

Variables

VM srquments:

“noverfFy —javaagent:'Ci\Program Fles|ZeroTurnaround| Rebelrebel

“Direbel log=trus -Drebelog.fie="C:{program Fies|ZeroTurmaround| Rebel rebel.J
~HI15256m -KxS121n KX MaxPermize=256m -Dsun. 1. gt clent.acInterv:
“Disva.endorsed.drs="C:ijavaljboss-4.2.2.GAllblendorsed"

Variables.

Working drectory:
Opefayt:

@ other Ciljavaljboss-4.2.2.GAjbin





